
 

ILWIS exercise 1 

ILWIS EXERCISE 

Quick introduction to ILWIS 3.1 

Objectives 
This exercise is intended to introduce you to ILWIS 3.1, and specifically to the user 
interface and some key concepts of ILWIS. It is a quick introduction based on the 
chapters 1 and 2 of the ILWIS 3.0 User’s Guide. 

ILWIS Main window 

 

To start ILWIS 3.1, double-click the ILWIS icon on the desktop. After the logo, 
you see the ILWIS Main window (see Figure 1). From this window you can 
manage your data and start all operations and select all data. 
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Figure 1: The ILWIS Main window. 
 

F  
• Have a look at the ILWIS Main window and find out what the 

individual parts of the window are meant for. 

! To get more information on the ILWIS Main window, press the F1-key or open 
the Help menu and select Help on this Window. 
Go to section 1.1 of the ILWIS 3.0 User’s Guide if you wish to practice some 
more with the individual parts of the Main window. 

Before continuing with the exercises you first need to change to the subdirectory 
that stores the data files for this exercise. Ask your supervisor where you can find 
the dataset. 
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F  
• Use the Navigator to browse to the correct directory. 

 
If you have browsed to the correct directory you will see in the Main window a list 
of ILWIS objects. This part of the Main window, in which maps, tables and other 
ILWIS objects in the working directory are displayed each with its own type of icon, 
is called a Catalog (see Figure 2). 

 
Figure 2: Example of a Catalog of the ILWIS Main window. 

 
ILWIS objects commonly used are: 

 Raster maps (for example Tmb1) 

 Polygon maps (for example Cityblock) 

 Segment maps (for example Contour) 

 Point maps (for example Rainfall) 

 Tables (for example Rainfall) 

 Domains (for example Cityblock) 

 Representations (for example Landuse) 

 Coordinate systems (for example Cochabamba) 

 Georeferences (for example Tmgeo) 
The first five objects are called data objects. They contain the actual data. The other 
objects are service objects; they contain accessories that data objects need besides 
the data itself. 

! For a complete list of ILWIS objects and their icons, see the ILWIS Help topic 
Basic concepts, ILWIS objects and icons. 

F  
• Position the mouse pointer on polygon map  Landuse. A 

description of this map will appear on the Status bar. 
  

The Status bar also gives short information when you move the mouse pointer to a 
menu command, to a button in the Toolbar or to an operation in the Operation-
Tree or Operation-List. 

 

F  
• Click in the Catalog with the right mouse button on polygon map 

Landuse to get a context-sensitive menu. 
  

A context-sensitive menu is a menu, which gives only those menu commands that 
are applicable to the moment you use the right mouse button; thus you will only get 
the operations, which can be applied on polygon map Landuse. 

ILWIS dialog boxes 

F  
• Double-click polygon map Landuse in the Catalog. The Display 

Options – Polygon Map dialog box (see Figure 3) is opened. 
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Figure 3: Example of a Display Options - Polygon Map dialog box. 

 
A dialog box allows the user to enter the information required by ILWIS to carry out 
an operation. Dialog boxes differ depending on the application you are performing. 

! Read pages 14 and 15 of the ILWIS 3.0 User’s Guide or click the Help button 
to get more detailed information about the Display Options - Polygon Map 
dialog box. 

A map window 

F  
• Accept the defaults by clicking OK. Polygon map Landuse is 

displayed in a map window (see Figure 4). 
 

A map window has many similar features as the Main window of ILWIS, which we 
have seen before. 

! To get more information on a map window, press the F1-key or open the Help 
menu and select Help on this Window. 

F  
• Press the left mouse button on different units in the map to find out 

what they represent. 

• Find the land use class around the location: X=801830 and 
Y=8089283. 

 
   Domain As you can see, the units of the Landuse map are described by classes, with names 

such as Forest, Grassland, Bare rock, Lake, etc. The list of all class names 
that can occur in a map is called in ILWIS a domain. A domain defines the possible 
contents of a map, a table, or a column. In other words, what do the items in a map, 
table or column mean? Are they classes (such as land use classes), or values or 
something else? All ILWIS data objects have a domain. The four most important 
types of domains are: 
− Class domains for data objects that contain classes (e.g. land use units, 

geomorphological units); 
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− ID domains for data objects that contain unique identifiers (e.g. city block 102, 
rainfall station Laguna); 

− Value domains for data objects that contain measured, calculated or 
interpolated values (e.g. height, concentration); 

− The Image domain for satellite images or scanned aerial photographs 
containing values between 0 and 255. 

! The domain concept is very essential in ILWIS. See the ILWIS Help topic 
ILWIS Objects, Domains for more detail.  
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Figure 4: An ILWIS map window. 

 

F  
• Double-click with the left mouse button a unit in the polygon map 

Landuse. 
 

Now you will see a small window appearing with the title Attributes. Inside the 
window you will see two lines. The first line contains the land use class name of the 
unit you clicked, and the second line contains the word Landvalue followed by a 
number, which is the average monetary value of this land use type. The line with 
Landvalue information is a line from an attribute table Landuse, which is linked 
to the map. 

A table window 

F  
• Close the Attributes window and double-click table Landuse in the 

Catalog. 
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The table Landuse is now displayed in a table window (see Figure 5). As you can 
see from Figure 5, a table window contains many of the features we have already 
seen in the Main window and in the map window.  
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Figure 5: An ILWIS table window. 

! To get more information on a table window, press the F1-key or open the Help 
menu and select Help on this Window or read pages 14 and 15 of the ILWIS 
3.0 User’s Guide. 

The table contains two columns. The left column, in gray color, has no header. If 
you look closely to the names in this left column you will remember that those are 
the names that you have seen in the map Landuse. This is the domain of the table. 
A domain can thus define the contents of a map as well as the contents of a table. 
Next to the left gray column containing the domain items, the table has one more 
column, called Landvalue. This column is an attribute column that contains the 
average value of the land in fictive monetary values. This column uses a Value 
domain. 

 

F  
• Double-click the Column header with the name Landvalue on it. 

The Column Properties dialog box (Figure 6) appears.  
 

This dialog box contains information on column Landvalue.  

! Click the Help button to get more detailed information about the Column 
Properties dialog box. 

F  
• Click the Cancel button to close the Column Properties dialog box. 

 
In section 1.2 of the ILWIS 3.0 User’s Guide many more options of the table 
window are treated. For now, close table Landuse. 
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Figure 6: Example of a Column Properties dialog box. 

 

F  
• Open raster map  Landuse in another map window and drag and 

successively resize both windows so that they are next to each other. 
 

The first impression is that the polygon map and the raster map are the same. They 
are similar with respect to the information they contain. You can check this by 
clicking the same unit in both maps. The units of both maps are also displayed in the 
same colors. The difference, however, is in the way the information is stored in both 
maps; one in vector format and the other in raster format. The best way to evaluate 
this is by zooming in on both maps. 

 

F  
• Click the Zoom In button  in the Toolbar of the polygon map. 

Position the mouse pointer in a section of the map near the boundary 
of several units (for example near the lake). Press the left mouse 
button, hold it down, and drag it to define a small area to zoom in on. 

• Repeat this procedure for the raster map. Zoom in on the same area. 
 

Now you can see quite some differences between the two maps. The polygon map 
displays smooth boundaries between the units, whereas the raster map has a blocky 
appearance. 

 

F  
• Close the map window that displays raster map Landuse. 

• In the Catalog select satellite image Tmb1 and drag it to the map 
window that displays the polygon map. The Display Options - 
Raster Map dialog box is opened. 

• Accept the defaults and click OK. Raster map Tmb1 is now added to 
the map window.  

 
In the map window, polygon map Landuse is displayed on top of raster map 
Tmb1. Each of the maps displayed in a map window is called a data layer. 
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Layer management 

F  
• In the Layer Management pane, drag and drop the Landuse 

polygon data layer below the Tmb1 data layer. Now raster map Tmb1 
is displayed on top of polygon map Landuse. 

• Press the Normal button  in the Toolbar of the map window to go 
back from the Zoom In mode to the Normal mode, and subsequently 
click individual pixels with the left mouse button. The values that can 
be read from the map are the values of raster map Tmb1. 

• Double-click Tmb1 in the Layer Management pane. The Display 
Options – Raster Map dialog box of raster map Tmb1 appears. 

• In the Display Options – Raster Map dialog box clear the Info 
check box. This means that you will not see the values of the pixels 
anymore when clicking in the map. 

• Accept all other defaults and click OK. Note that in the Layer 
Management pane the i in front of the Tmb1 check box has 
disappeared. 

• Move again with the mouse pointer through the map while keeping 
the left mouse button pressed. The classes that can be read from the 
map viewer are the class names of polygon map Landuse. 

Pixel Information window 
ILWIS has a special tool with which you can examine multiple maps and linked 
tables simultaneously: the pixel information window. 

  

F  
• In the map window, open the File menu and select Open Pixel 

Information. The pixel information window (Figure 7) is opened. 
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Figure 7: An ILWIS pixel information window. 

! To get more information on a pixel information window, press the F1-key or 
open the Help menu and select Help on this Window. 

F  
• Position both windows next to each other and move the mouse pointer 

over the map. In the pixel information window, you can read the 
information of map Tmb1 and of map Landuse at the same location. 

• Close the pixel information window by double-clicking the Control 
menu icon . 
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• In the Layer Management pane expand the Properties tree of 
polygon map Landuse and double-click  landuse – Domain 
Class to open the Domain Class editor (see Figure 8). 

 
As you can see, domain Landuse lists all possible class names of polygon map 
Landuse. It is simply a list of all land use types, which can occur in the map. 

Domain Class editor 

 
Figure 8: The Domain Class editor. 

! To get more information on the Domain Class editor, press the F1-key or 
open the Help menu and select Help on this Window. 
Go to section 2.3 of the ILWIS 3.0 User’s Guide if you want to practice some 
more with different types of domains. 

F  
• Close the Domain Class editor. 

• The Layer Management pane shows the Legend of the Landuse 
map, which is in fact representation Landuse. Double-click the word 
Legend in the Layer Management pane. The Representation 
Class editor is opened in the polygon mode (see Figure 9). 

Representation Class editor 

 
Figure 9: The Representation Class editor. 
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! To get more information on the Representation Class editor, press the F1-key 
or open the Help menu and select Help on this Window. 

As a domain determines what items can be stored in a map (or a table or a column), 
a representation defines how these items should be represented on a screen or a 
printout (e.g. color). Colors can be edited by clicking on an item, and then changing 
the Red/Green/Blue amount, by dragging the slide bars in the Color Slider, by 
selecting a color in the Color Selector or by double-clicking an item in the 
Representation editor. 

 

F  
• Practice with changing colors as explained above.  

• Have a look at the other menu items, try some and close the 
Representation Class editor. 

• After that go to the Layer Management pane, select polygon map 

Landuse and click the Remove Layer button  in the Toolbar of 
the map window. The Remove Layer box appears with the question 
Remove Polygon Map “Landuse” Are you sure? 

• Answer this question with Yes. 

Polygon map 
We will now look at polygon map Cityblock, which contains the city blocks of a 
part of the city of Cochabamba.  

 

F  
• Add polygon map Cityblock to the map window, zoom in and 

click the different city blocks to know there content. 
 

You will see that each city block is identified by a number. These IDs are usually 
just numbers without a certain meaning. Additional information from each 
individual block can be obtained from the attribute table that is connected to the 
map.  

 

F  
• In the Layer Management pane double-click polygon map 

Cityblock to open the Display Options – Polygon Map dialog 
box.  

• Select the Attribute check box, choose attribute column LandUse 
with Representation City_Landuse and click OK. 

 
Polygon map Cityblock shows the prevailing land use type within a city block. 

Segment map 
Let us now add another data layer to the map window: a segment map containing 
digitized contour lines. 

 

F  
• Click the Entire Map button  and add segment map Contour. 

In the Display Options - Segment Map dialog box, select the Info 
check box, accept all other defaults and click OK. Segment map 
Contour is now added to the map window.   

• Click the contour lines and read their meaning. 
 

The contour lines are all coded according to their elevation. In this case the contents 
cannot be represented as classes, but as values. The map Contour therefore has a 
value domain.  
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F  
• Open the domain  Height.  

 
A value domain looks quite different from a class or ID domain. It is not a list of 
names or codes, but it is a definition of certain values that should be used in a map 
or a column. For the Cochabamba area, height values range from 2500 to 4600 
meters.  

 

F  
• Close the Height domain. 

• In the Catalog, click domain Height with the right mouse button, 
and select the Properties command from the context-sensitive menu. 
The Properties sheet is opened. As you can see, domain Height has 
a representation value called Height. 

• Close the Properties sheet and open representation Height. The 
Representation Value editor is opened. 

• Have a look at representation Height. 
 

A representation for a value domain is defined on the basis of a number of limiting 
values between which the color changes from one color to another in a number of 
user-defined steps. 

! To get more information on the Representation Value editor, press the F1-
key or open the Help menu and select Help on this Window. 

Point map 
Finally, let us have a look at point map Rainfall containing fictive locations of 
rainfall stations in the Cochabamba area. 

 

F  
• Close the Representation Value editor and drag and drop point map 

Rainfall to the map window. The Display Options - Point Map 
dialog box appears. Please note that point map Rainfall also uses 
an ID domain since each name is only valid for one rainfall station 
only. 

• Select the check box Text. Some extra text options appear. 

• Click the Font button to open the Font dialog box. 

• In the Font dialog box, select Font: Arial, Font Style: Regular 
and Size: 8 and click OK. 

• In the Display Options – Point Map dialog box, select Text Color: 
Yellow and click the Symbol button.  

• In the Symbol dialog box select Symbol Type: Simple, Symbol: 
Square, Size: 5, Fill Color: Yellow, Line Width: 1, and Color: 
Red.  

• Click OK in the Symbol dialog box. 

• Click OK in the Display Options - Points dialog box. The point map 
is now added to the map window. 

• Close the map window when you have finished the exercise. 

Object properties 
As shown in preceding sections, different data and service objects are required to 
form a map in ILWIS.  The properties of an object show which service objects are 
used for a data object or another service object. A vector map needs a coordinate 
system, a domain and a representation. These service objects are also needed for 
raster maps, together with another type of service object: a georeference.  
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In Figures 2.4 and 2.5 of the ILWIS 3.0 User’s Guide, a schematic representation 
is shown of the properties of vector and raster maps. To understand these figures it is 
good to look at the properties of domain Landuse. 

 

F  
• Inspect the Figures 2.4 and 2.5 of the ILWIS 3.0 User’s Guide. 
• Click in the Catalog with the right mouse button on class domain 

Landuse, and select Properties from the context-sensitive menu. 
The Properties sheet is opened.  

• Click the Used By tab. 
 

You see a list of objects that are using this domain Landuse: raster map 
Landuse, polygon map Landuse, table Landuse, and representation Landuse. 

 

F  
• Compare the result with Figure 2.4 and close the Properties sheet 

afterwards. 

Dependencies 
When maps are used to create other maps, for instance by performing an operation 
or executing an expression, then this operation or expression and the input map 
name(s) are stored inside the new map. This is what ILWIS calls dependency. 
Output maps thus know how they are created and on which input maps, tables or 
columns they depend. Such output maps are called dependent data objects. The 
same applies for tables and columns. The operation or expression stored inside the 
dependent data object is called the definition.  
Let us look at an example. Polygon map Landuse was used in combination with 
the georeference Cochabamba to generate a raster map Landuse. This is shown 
schematically in Figure 10. 

 
Figure 10:  The dependency link between objects. The output raster map is 

made from a polygon map and a georeference, using the 
Polygon to Raster operation. 

 
The dependent raster map, which is the result of the Polygon to Raster operation 
(i.e. the Rasterize Polygon Map operation), contains information on the source 
objects from which it was created. In this case a polygon map and a georeference. 
Let us check this example in the data set. 

 

F  
• Click in the Catalog with the right mouse button on raster map 
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Landuse and select Properties from the context-sensitive menu. 
The Properties sheet with the title Properties of Dependent Raster 
Map “Landuse” is opened (see Figure 11). 

 

 
Figure 11: Example of a Properties sheet. 

 
The Raster Map tab gives you information on the service objects of this map and 
information on how the map was made (i.e. the Definition):  

! Click the Help button to get more detailed information about the Raster Map 
Properties dialog box. 

F  
• Click on the Dependency tab. Note that the line below the 

expression MapRasterizePolygon(Landuse.mpa, 
Cochabamba.grf)says: Object is up-to-date. 

 
This means that none of the source objects (i.e. polygon map Landuse and 
georeference Cochabamba) have been updated since the dependent raster map was 
generated.  

 

F  
• Close the Properties sheet of raster map Landuse. 

• In the Main window click the Details button  in the Standard 
toolbar. The Catalog, which is currently active, changes from a List 
View into a Details View. 

• Check the columns D, C, U and Modified. You will see that all the 
maps are modified on the same date and time and that raster map 
Landuse is Dependent (D), Calculated (C) and Up-to-Date (U). 
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Now we are going to update the source polygon map Landuse. 
 

F  
• In the Catalog click with the right mouse button on polygon map 

Landuse and select Edit from the context-sensitive menu. 

• In the Polygon editor change for example the polygon Lake, near the 
Urban centre, into Urban periphery and close the window 
afterwards.  

 
The polygon map is updated now. In the Catalog of the Main window you can see 
that the polygon map Landuse has been modified and that raster map Landuse is 
now Dependent (D), Calculated (C) and Not Up-to-Date (N). 

 

F  
• Open the Properties sheet of raster map Landuse. On the 

Dependency tab you see: Object is not up-to-date: 
Landuse.mpa (day date time). 

 
It is important to keep in mind that dependent maps are not automatically updated. 
ILWIS does keep track of the dates and times at which the source objects were 
modified. Only when you click the button Make Up-to-Date on the Dependency 
tab of the Properties sheet, ILWIS will ask you if you want to recalculate the map. 

 

F  
• Click the Make Up-to-Date button. A Check Up-to-date message 

appears with the question Dependent raster map “Landuse” 
is not up-to-date. Recalculate it to make it up-to-
date? 

• Answer Yes to this question to recalculate the map.  

• Open the Properties sheet of raster map Landuse. On the 
Dependency tab you see that the Object is up-to-date again. 

• Click the button Release Disk Space. The Release Disk Space 
dialog box appears. 

• Click Yes in the Release Disk Space dialog box. The Properties 
sheet closes. 

 
Now the actual data file of the raster map is deleted. Only the definition of the map 
remains, so the map can always be recalculated. In the Catalog of the Main window 
you see that the raster map Landuse is now Dependent (D), Not Calculated (N) 
and Not Up-to-Date (N). We will recalculate the data file of the raster map below. 

 

F  
• Open the Properties sheet of raster map Landuse. 

• On the Dependency tab, click the Calculate button. 
 

A so-called tranquilizer is displayed, showing the progress of the calculation of the 
map. When it stops, the raster map Landuse is again Dependent (D), Calculated 
(C) and Up-to-Date (U). 
It is also possible to convert a map (or a table, or a column) from being a dependent 
object to a source object.  In that case you will break the dependency link. After that, 
the map cannot be updated anymore from the Properties sheet. You actually need 
to do the operation again. 

 

F  
• Open the Properties sheet of raster map Landuse. 

• On the Dependency tab, click the button Break Dependency Link. 
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A Break Dependency Link message appears. 
• Confirm the question with Yes. The Properties sheet is closed. 

• Open the Properties sheet again and note the difference. 
 


